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    INTRODUCTION


    Welcome to Sparkle, the professional web development application for the Mac. Among all the products available about this theme, Sparkle stands out for its ease of setting up pages, texts, images, menus and other objects that organize the structure of your site. Moreover, once the parameters of the Internet host have been specified, the deployment of the site is completely automated.


    Any changes to the site can be tested on your browser then published. No HTML or CSS code is required. Everything is done by the application without any programming.


    I created my remylent.fr website with Sparkle for simplicity and speed reasons.


    In this manual, you will discover how to organize and create a website with several pages. There are several versions of Sparkle and the following list details the different possibilities and their costs (at the time of writing this book):


    
      	The free but very limited version.


      	The Sparkle Basic version costs $32.99 with a license for one or more Macs, publishing a single site with only 10 web pages.


      	The Sparkle One version costs $54.99 with a single or multiple Mac license, single site publishing, Google Analytics, site searching, blogging and other features.


      	The Sparkle Pro version costs $119.99 with a license for one or more Macs, unlimited site publishing, Google Analytics, site searching, blogging, Pop-ups, parallax effects, GoogleAdSense, SEO Wizard, checkout buttons, calendars, exporting HTML to disk, Instagram support, filter panel, etc.

    


    Check out the next page for more information on the different versions.


    https://sparkleapp.com/store/
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    This book is divided into 5 chapters.


    Chapter 1 shows the working environment, the horizontal menu, the tools, and the configuration settings that are necessary for publishing the website. You will also discover the Pro version advantages.


    Chapter 2 deals with both page management and the properties panel that provide information about the characteristics of the inserted objects.


    Chapter 3 explains the elements you can place in pages, such as text boxes, text input, images, videos, lists paragraphs management, etc.


    Chapter 4 details how to link pages together, through elements, links and possible actions. You will learn how to define a footer or header and a customized menu based on a section.


    Chapter 5 focuses on styles and forms that can help you in your daily work.


    I hope this book will enable you to manipulate Sparkle more easily when creating your website.


    Do not hesitate to contact me at remylent@gmail.com if you have any comments or questions about this book.


    I will be sure to answer you.


    Enjoy the reading.


    The author

  


  
    Chapter 1

    The working environment


    This chapter shows the working environment, the menus and the settings for the website publishing.


    1.1 Installation, menus and tools


    To install Sparkle, go to the Apple Store and install the free version. Thereafter, you will be able to choose a paid version that suits you best.


    As in any Mac application, you will find a horizontal menu and tools in the window.


    Depending on the Sparkle version, some features may not be available. For example, in the Sparkle One version, you do not have access to the Layers tab that are located next to the Pages tab. However, it does not prevent you from creating and managing your website.


    Figure 1.1 shows this working environment.
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    Figure 1.1 : The working environment


    1.1.1 The window organization


    Sparkle is divided into several parts:


    
      	The left panel deals with the web pages of your site.


      	The right panel presents the properties of the pages but also of the objects that you will place in them during the development. For example, it can be the position of a text zone.


      	The tools panel contains the working icons.


      	The horizontal menu offers all the available actions.

    


    If you have any problems, please do not hesitate to contact the Sparkle hotline via Help / Contact Sparkle. Someone will answer and help you.


    Figure 1.2 shows my site in the design mode.
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    Figure 1.2 : The design mode


    1.1.2 The horizontal menu


    Let's start with the Sparkle menu (figure 1.3) that proposes general information: the application preferences, your current license, several keyboard shortcuts like Cmd H to hide the application in the dock or Cmd Q to quit Sparkle.
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    Figure 1.3 : The Sparkle menu


    The File menu shows the features for creating, opening and saving the file (the extension is .sparkle) that will contain all the web site elements.


    Figure 1.4 shows the SEO Assistant option (only with the Pro version) which helps you to better reference the web pages thanks to improvements applied to title name, links, images name and anything else that can enhance the SEO.


    The assistant provides a dialog box where you can see the modifications to be made. It is possible to run the SEO as many time as needed.
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    Figure 1.4 : The File menu options


    With the Edit menu, you have access to the classic copy-paste-cut-delete features, etc.
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    Figure 1.5 : The Edit menu options


    The Insert menu option enables you to insert all kinds of tools, such as text boxes, images, buttons, customized menus and many more. Some of these are only available with the Pro version.
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    Figure 1.6 : The Insert menu


    The Format menu enables you to change the character style and the paragraph alignments (center, left or right). Keep in mind to select the text before using these features.
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    Figure 1.7 : The Format menu


    The Arrange menu allows you to place objects in relation to each other. For instance, to place a box behind an ellipse or another shape. You can also lock or group objects.


    You can select several objects then move them to a layout block. This feature creates a rectangle shape with the selected objects in order to enhance their presentation. Thereafter, the block settings can be edited with the right panel.
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    Figure 1.8 : The Arrange menu


    The View menu enables you to display grids, guides, document boundaries and view features such as zooming, keyboard shortcuts, light color theme, etc.
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    Figure 1.9 : The view menu


    The Upgrade menu permits to upgrade the application to a different version.
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    Figure 1.10 : The Upgrade menu


    The Window menu provides features for managing the windows in case you are working with multiple projects at the same time.
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    Figure 1.11 : The Window menu


    1.2 The toolbar


    Below the menus, tools appear represented by icons. They make possible to quickly access the various possibilities.
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    Figure 1.12 : The tools


    The following list details the various tools present in the default panel.


    
      	Zoom. Adjust the page according to your needs. You can select predefined values (from 25% to 400%), as shown in figure 1.13.

    


    [image: ]


    Figure 1.13 : Predefined zoom values


    
      	Device. This tool enables you to format the display according to the type of device on which you plan to develop your website. For instance, it can be a 1200 pixels screen for a desktop computer, a tablet with a landscape format at 960 pixels or with a portrait format at 768 pixels. You can also develop a web site for a smartphone with a landscape or portrait format.

    


    Caution. Think carefully about how your website will be visible on the different devices, via the browsers that exist on the market.


    Indeed, if you develop an application for a desktop computer with a landscape format, chances are that it will not be completely visible on a smartphone. So, you have to find a compromise between what you can do and your future goal.


    On my site, I chose to organize my pages in the middle of the screen to have a chance to be visible with Google, Safari, Opera, Explorer and a few other browsers.


    Figure 1.14 shows the different device possibilities.
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    Figure 1.14 : Different device formats


    Another advantage of Sparkle is the possibility to display the pages with a Responsive way, which means the pages automatically adapt themselves to the portrait and landscape format, when you turn the phone or the tablet. The important thing is to adapt to the different device formats when choosing parameters.


    
      	Grid. This feature can help you place images, shapes, texts or any other object in a more precise way. The grid displays separating columns with a gutter that indicates the distance between them. When you align an image near the column, a slight magnetization effect occurs, making it easier to position the image.

    


    Figure 1.15 shows a grid of 10 columns and a gutter of 22 pixels (px).
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    Figure 1.15 : The grid


    
      	Page. This feature allows you to create pages in the left panel. They can also be grouped by Section. When you create a menu in a page, the section can be used to automatically display the name of the pages. When creating a page, you have to decide the top level one inside the section.

    


    Figure 1.16 shows the Page icon choices.
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    Figure 1.16 : The Page tool


    The Page tool is linked with the Menu feature. When you insert a Menu object in a page, Sparkle retrieves the name of the page placed in the section. If some pages are added thereafter in the section, they will be automatically placed in the menu.


    You can also modify the shape of the menu. This new format will be reflected in all the section pages. This is why Sparkle displays: "When used with element visibility, sections help in applying a common page look". Sections and menus will be studied later in the book at chapter 4.


    
      	Blog. This feature allows you to create blogs (only with the Pro version).
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    Figure 1.17 : The Blog tool


    
      	Text. This option creates a text box that you can fill in.
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    Figure 1.18 : Inserting a text box.


    
      	Layout Bloc. This feature creates a rectangle area that can contain other objects (figure 1.19). The bloc can be enlarged or moved pushing down other layout blocks that come after it. The Layout Blocks are similar to boxes and provide a visual structure for the page.
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    Figure 1.19 : Inserting a Layout bloc.


    The Layout Bloc allows images to appear on top of text or other images with a scroll (particularly beneficial or unacceptable according to people) to promote ads or other information.


    
      	Box. You can add a rectangle box and change many settings such as color, border, rounding, shadow, etc. (figure 1.20).
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    Figure 1.20 : Inserting a box


    
      	Image. It creates an area where you can insert an image file. Several image type are available.
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    Figure 1.21 : Inserting an image


    
      	Sign +. You can add other features depending on the version of your Sparkle application. Figure 1.22 shows the other icons.
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    Figure 1.22 : Other tools


    
      	SEO. The acronym SEO stands for Search Engine Optimization. SEO is not installed by default in Sparkle, and you must upgrade to the Pro version. It offers many features that, coupled with the organization of your pages and sections, will increase your visibility improving SEO. This assistant researches the errors that are within the pages.
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    Figure 1.23 : The SEO in action


    
      	Settings. These are website parameters.
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    Figure 1.24 : Website settings


    
      	Overview. At any time, you can check the result of your design work by requesting a Preview. Sparkle suggests several browsers (figure 1.25).
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    Figure 1.25 : The preview before publishing


    
      	Publish. When the design of your site is complete, you can publish it to your web host, who will automatically receive all the files, images and objects inserted into your pages. After the publishing, users will be able to refer to it.
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    Figure 1.26 : Publishing the site to the host


    The Setup button enables you to enter the necessary parameters for publication.


    1.3 The configuration settings


    Publication is the final step in the creation of your website. It is organized around your pages, content, images but also HTML, CSS and JavaScript codes that Sparkle writes in the background. All of these objects will be sent to your website host at this time.


    By clicking on the Setup button, Sparkle displays several tabs. The Publishing tab is important for the FTP address in order to send data to the Internet server (the host).


    Figure 1.27 shows the settings for my website.
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    Figure 1.27 : Configuration settings for publishing


    With Sparkle, there is no need to know the code, everything is done in the background through the working environment. Nevertheless, if you are interested in programming, don't hesitate to buy the professional version that offers some Developer options.


    1.4 Overview and publication of the site


    As your web site progresses, you can check the result by previewing it before publication. Sparkle will show you the content of the pages in a browser window.


    To preview your site, perform the following steps:


    
      	Click on the Preview icon in the toolbar.


      	Choose the browser as shown in figure 1.28.
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    Figure 1.28 : Previewing the site


    
      	Click on the Open Live Preview button.

    


    Once your work is finished, you can publish it to your website. All the files, images, videos, etc. will be transferred to your Internet provider.


    To publish your site, perform the following steps:


    
      	Click on the Publish icon in the toolbar.


      	Check the configuration settings.


      	Click on the Publish button a second time.

    


    1.5 Some advantages of the Pro version


    The professional version offers more elaborate tools that increase development capabilities.


    1.5.1 Development tools


    In the configuration menu, programming tools are available in the Developer tab. It is possible to add CSS or JavaScript files at the start of a program.


    Figure 1.29 shows these possibilities.
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    Figure 1.29 : Development tools


    1.5.2 Payment button tools


    Sparkle enables you to insert links to various online payment applications, such as PayPal, Stripe, SnipCard and others. These applications add shopping cart platforms to your website environment.


    Figure 1.30 shows the capabilities of the Pro version in the Payments tab.
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    Figure 1.30 : Payment device integration


    I use PayPal as my online payment manager for my books. It provides me with an HTML code that I insert into the pages of my website. This code automatically displays the payment button. It is not an extremely sophisticated feature because there is no shopping cart. Anyway, it works very well.


    1.5.3 Layers


    The professional version enables you to access more easily the page objects thanks to the Layers. This feature displays a list of all the object names. If you click on a name, the pointer will automatically move to it.


    Figure 1.31 shows an example.
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    Figure 1.31 : Layers in the Pro version


    Layers are useful in the creating of Forms that are customized dialog boxes. In a form, you can insert a text input box, checkbox, radio button, drop-down selection, buttons and all this information can be sent to a server thanks to a communication protocol. These features are explained in chapter 5.


    1.5.4 The SEO wizard


    Sparkle Pro provides this wizard to help you find problems that may reduce the effectiveness of your pages with search engines. For example, you may have forgotten to give a title to a page, an image does not contain a caption, a link to a website seems to be disabled, etc.


    After running the wizard, Sparkle displays a window that lists all potential problems. Then, you are guided to fix the errors. Precedent figure 1.23 shows the SEO wizard in action.


    1.5.5 The parallax effect


    When you move the pointer down a page, some elements appear to overlap others. For instance, an image is placed on top of a page background, with a movement effect. These 3D effects cause visual illusions that are very pleasant (or not) to see. These are called parallax effects.


    Sparkle provides project templates that show these features when objects move relative to each other. Many development applications now use this parallax effect.


    In brief


    Sparkle is a web application that works for the Mac. You can build websites through panels and menus. There is no need to know any code. The Pro version offers tools that can help you to improve your site.


    Chapter 2 will focus on creating pages and their many properties.

  


  
    Chapter 2

    The pages


    This chapter details how to create pages and link them together. The right-hand panel is often called Inspector. It displays the features that you can use in a page. When creating a website, you have to think about its design layout.


    2.1 The site composition


    Whatever your future website, it will have a structure that organizes the pages linked to each other. You must think about this before starting. Sparkle is flexible enough to enable you to change your focus along the way. For instance, you can add a new link or a button that will point to a new page you hadn't thought of.


    The backbone of a website starts with a page called the Home Page. It is at the top level and does not contain other groups of pages, such as sections. The other pages are defined as Regular. Home Page or Regular Page are specified in the right panel.


    Figure 2.1 shows the Home Page of my web site. The information is centered in order to improve the visibility for web browsers and digital tablets.
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    Figure 2.1 : The home page


    Three buttons call up two different pages that contain information about the books to be sold. On each page, a button enables you to return to the home page. Sparkle can create links between pages very easily because each page is named thanks to the properties panel.


    Figure 2.2 shows the page that appears when the first button is clicked. It is a set of English books. Another button enables the user to return to the Home page.


    If the user selects a book, a third web page will display the book information. Purchase buttons call the PayPal application. Another partner site is also possible for payment.


    Each book has a specific page through links that you define in the right panel.
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    Figure 2.2 : The English book pages


    Red texts are links used to return to the main page.


    My site organization is extremely simple. The objective was to show a quick view of the different books. But Sparkle offers more advanced features, such as drop-down menus, text entry boxes, checkboxes, radio buttons, all of which can help you to create a form with a server interaction.


    Once you have defined the layout of your site and your objectives, you can start creating your pages.


    2.2 Managing pages


    Follow the steps below to create the Sparkle file that will contain all elements of your site:


    
      	Start Sparkle.


      	Click on the Blank template. The other templates show other possibilities.
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    Figure 2.3 : Selecting the Blank template


    Sparkle displays the workspace window in which you will be able to create as many pages as you want (unless you are working with the free version).


    Figure 2.4 shows this layout. The left panel is intended for the pages or for the grouping of pages with Sections. The center part of the windows is used to place the objects like texts, images, buttons, etc. The right part is the properties panel where you can define the object characteristics.


    [image: ]


    Figure 2.4 : The workspace


    2.2.1 Adding a page


    To add a page, perform the following steps:


    
      	Click on the sign (+) at the bottom left of the window


      	Select Top Level from the list (figure 2.5) then click on Add Page.

    


    You can create a section which is a group of pages that helps you to better organize pages.
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    Figure 2.5 : Adding a page


    2.2.2 Deleting a page


    To delete a page, perform the following steps:


    
      	Select the page to delete.


      	Click on the sign (-) at the bottom left of the window. You can select multiple pages (with the Cmd key) before deleting them.

    


    2.2.3 Duplicating a page


    To duplicate a page, perform the following steps:


    
      	Select the page.


      	Click on the icon placed between the minus and plus signs.

    


    2.2.4 Defining the home page


    It is the page located at the top of your pages hierarchy. The other pages are defined as Regular. The home page is defined internally by the word index.html.


    The other pages must be renamed for a better search engine optimization.


    To define a home page, follow the steps below:


    
      	Select the page.


      	In the right panel, choose Home Page (figure 2.6)
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    Figure 2.6 : The Home Page


    Notice that Sparkle automatically renames this page with the name index.html. It is not possible to have two home pages. If you try to do so, the other page will be redefined as a regular page.


    2.2.5 Renaming a page


    By default, when you create a page, Sparkle assigns a title with the word Page followed by a number. It increments from 1 to n, for instance, Page 1, Page 2, Page 3, etc. The HTML file name will be based on this title (Page-1.html, Page-2.html, Page-3.html, etc.).


    You must absolutely rename the title of each page in order to clarify each element of the site. If you click on the Custom Filename checkbox, you will be able to specify a specific name, while keeping the title given automatically by Sparkle.


    2.2.6 Top Level or Folder


    The Top Level setting means that the page will be published at the top level of your web host. Most of the time, it is the root "/". If you want a page (or a group of pages) to be saved in a subdirectory of the server, choose the In a Folder parameter, then specify the URL of the folder.


    You can also retrieve the URL of the page by clicking on the icon next to the word Copy. The address is thereafter saved to the clipboard. You can also copy a QR Code picture to share. In the Sparkle Pro version, a third icon corresponds to a QR Code (figure 2.7).
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    Figure 2.7 : Specifying a folder


    2.3 Referencing and research robots


    Referencing is improving the visibility of a website to increase the number of visits. To reference a site efficiently, search engine robots are used because they browse the Web and can find your site if using the right methods.


    Generally speaking, referencing is organized around the pages content, and this one must be very well structured with text and paragraph headings which indicate the importance of the words to be referenced.


    At the time of the publication , the page content is always translated into HTML code by Sparkle. The robots will locate the words or expressions that will often appear in the text, but especially the H1, H2, H3 and H4 tags that will be associated with them.


    The following list gives you some tips to achieve a good referencing:


    
      	Place several times the words you consider prominent in the text of the pages, but not disproportionately.


      	Place paragraph titles and mark them with HTML tags. For instance, the title will be affected by the H1 tag, the subtitles will all be marked by the H2 tag, etc.


      	Search engines are never interested in the meaning of the text, but rather in the keywords that are present in the text, and in the HTML tags. Moreover, you will improve your SEO if your page addresses are permalinks (permanent links used for page addresses) that contain only letters and not numbers.


      	Words with a Bold style are often recognized by robots.


      	Check that the file sitemap.xml that details the map of your site is saved on your server and have your site inspected by Google search Console at https://search.google.com/.


      	For each article in a page, define a title for the top of the page. Apply a tag level for each title.

    


    Figure 2.8 shows an example of headings in a page.
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    Figure 2.8 : Tagged headings for SEO


    2.3.1 The page description and the keywords


    For better referencing, describe the content of the page in the clearest way possible. Place important keywords that best characterize the subject of the page. Figure 2.9 shows this feature.
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    Figure 2.9 : Page description, keywords and other SEO features


    You can define a Social Card image if needed, allow or not the indexing of the page, exclude from publishing or from site search, etc.


    The button Optional metadata enables you to enter the author name of the page, keywords and a copyright. This data is never visible on the page.
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    Figure 2.10 : Metadata


    Metadata are data about the data. It provides details about the type of content that is displayed on the page.


    2.3.2 Indexing


    It is the action of a search engine (a program) that crawls the web indexing the content. When the robot indexes the page of your site, it copies the words that have been defined with marks like H1, H2, H3, H4, H5 in servers.


    The Google crawler is called Googlebot. It explores the pages of your site and follows the links that are present on the pages, in order to discover new ones, and to save their links into the servers (data center).


    Google only indexes pages that are indexable. With Sparkle, you can refuse this indexing.


    Figure 2.11 shows the area where you define these settings.
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    Figure 2.11 : Allowing or not page indexing


    In the list, three options are available: Indexing:default (allow), Indexing:deny and Indexing:allow.


    If you choose the third option, Sparkle will take into account the settings defined in the site parameters of the Search Engines tab (figure 2.12).
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    Figure 2.12 : The search engine settings


    If you do not decide to archive the page when you publish it, you will be able to preview it, but the page will not be exported to your host's site.


    The site parameters intervene inside a special file called sitemap.xlm which is a mapping of your site and absolutely necessary for the good indexing of the pages. This file is very important and must be located in the root of your host site. Sparkle is in charge of producing it.


    You can always ask Google to index your site via a particular URL: https://search.google.com/


    2.3.3 Social sharing


    This feature is intended for sharing images on social networks, in particular with Facebook. You must activate Generate Metadata for Social Sharing in the Sharing tab in the general settings.
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    Figure 2.13 : Metadata for Social Sharing


    You can specify a file for a picture to be shared on social networks (Facebook, Instagram, etc.). The picture will be considered as a shared card.


    2.3.4 Alignment and background


    These two settings enable you to align the page according to the type of device chosen for the publication.
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    Figure 2.14 : Alignment of all information on the page


    The background can be plain or contain a built-in pattern, a Custom pattern or a video from multiple sources. Embedded patterns can be fixed by preventing the background from scrolling with the page.


    You can specify the scale of the pattern or apply a blur effect.


    Double-click the pattern to see different examples.


    Figure 2.15 shows the parameters you can specify for background patterns.


    [image: ]


    Figure 2.15 : Different background patterns


    In brief


    A website is a set of pages organized in a well-defined layout. The left panel is used for creating, deleting and duplicating pages. The right panel allows you to specify parameters that will be used for search engine optimization.


    Chapter 3 will detail the elements that can be inserted in the pages.

  


  
    Chapter 3

    Page elements


    This chapter shows you how to insert the elements (texts, images, shapes, buttons, etc.) that you can place on the pages. You will discover their properties (positioning, styles, etc.) and how to link pages with actions that can be performed.


    3.1 Manipulating text


    You can manipulate any text, change the fonts, the bold style, the case or other adjustments by taking care to select the text before acting on it.


    3.1.1 Inserting a text box


    To insert a text on the page, follow the steps below:


    
      	Select the page in which you want to place the text.


      	Insert / Text Box (the keyboard shortcut is T).


      	Type the text into the box.

    


    Figure 3.1 shows the placeholder.
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    Figure 3.1 : The text placeholder


    Once the text has been inserted, you can modify its characteristics through the right panel using three tabs: Style, Arrange and Page.


    Four groups of settings are available: the Font group, the Paragraph group, the Click group and the Scroll effects group.


    It enables you to apply character and paragraph styles to selected text, to save time when texts need to have the same formatting.


    The OnClick group enables you to run an action, for instance to display another page or to go to an external link. The Pro version offers others features as Open or close a Popup. A Popup is a form that is a customized dialog box. It allows you to create a user-friendly oriented form.


    Figure 3.2 shows the style settings.
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    Figure 3.2 : The Style tab


    The Arrange tab enables you to modify the position and the size of the text more accurately. You can also define a footer and some features that wrap the text, as shown in in figure 3.3.
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    Figure 3.3 : The Arrange tab


    The Page tab is only intended for the page characteristics.


    3.1.2 Changing the font


    To change a font, click first on the edge of the text area or directly by selecting the text. Select the name of the desired font from the drop-down list.


    You can also click on the + which will show another font presentation (figure 3.4).
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    Figure 3.4 : Changing the font


    With the All Fonts tab, all available fonts are displayed. If you click on the one you are most interested in, a green corner will appear in the upper right corner. Click on the Inspector to exit this dialog box.


    Other features can help you to filter the fonts. To see more information about the types of fonts that Sparkle can handle, click on the red circle that contains the letter i.


    When you select a font that does not exist in your computer, a replacement family will be chosen based on a CSS font library defined in the System Fonts tab. It enables the Internet browser to choose an alternative font.


    3.1.3 Changing the greasing


    Depending on the different fonts, the greasing can take several forms. Click on the drop-down list below the font name (figure 3.5).
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    Figure 3.5 : Different types of greasing


    3.1.4 The advanced options


    Clicking on the cogwheel will bring up advanced options, such as capitalization (upper case, lower case), the baseline for the exponent or subscript (H2O, E=MC2, etc.), the text background color and the possibility of crossing out the text or applying a shadow with parameters.
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    Figure 3.6 : The advanced options


    3.1.5 Managing paragraphs


    Figure 3.7 shows the possibilities for handling paragraphs.
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    Figure 3.7 : Paragraph settings


    As in any word processing, you can align paragraphs to the left, right or center. If you justify the text, it will be stretched between the left and right margins. The last icon enables you to toggle between the left and right alignment.


    The First Line setting shifts the first line to the right, like an indent. The Space before and Space after settings enable you to insert spaces before or after the paragraph respectively.


    The HTML tag feature makes it easier to reference headings in the project. You can use the p, H1, H2, H3, H4, H5 and H6 tags to optimize the work of search engines.


    3.1.6 Creating a list


    The List feature transforms the paragraphs in the text area into a list whose items are preceded by an icon (bullets, squares, check marks, etc.) or a number. You can create and modify a hierarchy and the indentation of each item. Figure 3.8 shows an example of such a list.
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    Figure 3.8 : A list


    
      	To shift an item to the right, select the text then click on the sign > in the hierarchy area.


      	To shift an item to the left, select the text then click on the sign < in the hierarchy area.

    


    Figure 3.9 shows several indents to the right.
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    Figure 3.9 : Several indents


    3.1.7 Creating a list with a scrollbar


    Figure 3.10 shows a list with a scrollbar, thanks to the Scrollable feature. You can only see the result when previewing the page.
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    Figure 3.10 : A Scrollbar


    3.1.8 Framing text with rounded edges


    As you may have noticed, Sparkle does not allow you to set a border around a text box. However, you can create a simple box by formatting it correctly with rounded borders. Thereafter, you can place it behind the text, and that's it.


    Figure 3.11 shows text that is framed with rounded borders.
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    Figure 3.11 : Rounded border


    The following steps show how to do this:


    Step 1: Creating the text in a text box


    
      	Insert / Text Box


      	Enter the text.

    


    Step 2: Creating a simple box


    
      	Insert / Box

    


    Step 3: Changing the rounded borders.


    
      	Select the box.


      	In the Inspector, click on the Style tab.


      	Tick on Border.


      	Tick on Rounding then choose 45px.
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    Figure 3.12 : Bordering a box


    Step 4: Changing the color to the checkerboard pattern


    
      	Select the box.


      	Click on the Fill circle.


      	Choose the checkerboard pattern that makes the box transparent, as shown in figure 3.13.
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    Figure 3.13 : The transparent pattern


    Step 5: Moving the box above the text


    
      	Move the box above the text box, adapt it then group the objects together (Select them, right-click then choose Group).


      	Preview the page to see the result.

    


    [image: ]


    Figure 3.14 : The bordered text


    3.2 Inserting images


    You can insert a bitmap image (PNG, JPG, GIF, TIFF, etc.) dragging it from the Finder or by adding it from the selector. It is also possible to add SVG vector images.


    3.2.1 Adding an image to the page


    Follow the steps below to insert an image.


    
      	Insert


      	Image

    


    Sparkle will display a block in the page. Its properties will enable you to define the image to be added.


    
      	Click on the Add button, then select an image.
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    Figure 3.15 : Adding a image


    You can replace an existing image by dropping another image on top of it or in the settings.


    A image can also be integrated as a background in a box. JPEG and PNG images are compressed and fit into the selected area.


    
      	The Title zone is used to display a tooltip in the browser when the user hovers over the image with the mouse.


      	The Description zone is the correspondence of the Alt tag. It is used to display a text that is only displayed if the image file is not found by the browser.

    


    The three parameters Stretch, Fill or Fit enable the image to be adapted to the frame. When the Stretch parameter is deactivated, the image keeps its original dimensions. Its position can be aligned horizontally and vertically using the purple buttons.


    If the Stretch setting is enabled, Sparkle applies an appropriate scale factor. The Adjust button causes the entire image to be displayed. With the Fill button, the image covers the entire frame but is cropped at the edges.


    A Resolution report bar helps you to evaluate the quality of the output image in order to determine if there are enough pixels for a proper use. This bar updates automatically. Make sure you don't go below 2 pixels (2px), otherwise browsers may show a low resolution image. Sparkle supports browsers that run on high resolution (retina) or very high resolution (retina @3x) devices.


    Sparkle's documentation indicates that an image with a name ending in @2x or @3x (for instance logo@2x.png) will be reduced by half with a 1x size.
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    Figure 3.16 : The resolution bar


    3.2.2 Locking an image


    You can prevent an image (or any item) from being accidentally moved or deleted by locking it.


    
      	Select the image you want to lock.


      	Right-click then choose Lock.

    


    You can lock multiple items at the same time. The Unlock option performs the opposite action.


    3.2.3 The image gallery


    This feature enables you to store several images in a frame, which will scroll according to parameters such as speed, position, image transition, etc.


    In order for a gallery to be able to display images, you must first insert a Gallery object, then add the images. Further, you will define how they will be displayed.


    To add an image to the gallery, follow the steps below:


    
      	Insert / Image Gallery


      	Edit


      	Click on the Add button.


      	Select the images you want to add.

    


    Choose to store the images in This document rather than In original location. You will be able to access them even if the file is modified or deleted in the original folder.
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    Figure 3.17 : Inserting images in the gallery


    Several settings are possible. For instance, you can choose to trigger an action when clicking or hovering the mouse over a image, such as stopping the scrolling or accessing a specific page.


    The following list details these possibilities.


    
      	Edit. This button enables you to return to the image storage area.


      	Show Label. This feature enables you to display a specific text for the image. This label is filled in the text box that is placed immediately below the image. To return to the label, click on the image frame then on the label.
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    Figure 3.18 : Adding a label


    When selecting an image in the frame, a specific action can be triggered, as shown in in figure 3.19.


    [image: ]


    Figure 3.19 : The possible actions


    The list below details the different possibilities:


    
      	Zoom Image in Lightbox. The image appears larger in an external frame.


      	Go to Page in This Website. This option displays another page defined in the Inspector settings.


      	Go to External Link. This option enables you to declare an URL.


      	Open Email. This feature starts your computer's default mail application (Gmail, Outlook, Mail, etc.)


      	Call Phone Number. The number defined in the dedicated application is called.


      	Download File. This option enables you to download a file whose name is specified in the File name field.


      	Open Popup. This option enables you to bring up a configurable building block (a form).


      	Close Popup. This option enables you to close the form that was previously opened.

    


    The LetterBox setting enables you to set the display of images in the gallery frame.
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    Figure 3.20 : Setting up the display of images


    With the Stretch setting, Sparkle applies an appropriate scale factor. The Fit button causes the entire image to be displayed.


    With the Fill button, the image covers the whole frame but is cropped at the edges.


    Figure 3.21 shows the options for the Transition parameter, that is the display mode between two images. The Transition speed, in seconds, is the time for the Cross-fade or Slide effects .
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    Figure 3.21 : The images transition mode


    Figure 3.22 shows the other parameters that structure the image gallery, such as thumbnails, dots at the bottom of the gallery or moving arrows.


    With five or more images, you can add thumbnails. They can be placed above or below the image. You can control the distance, the margin and the color of the border of each selection.


    The more thumbnails you have, the smaller they are.


    You can define the position and color of the direction arrows. Dots can appear at the bottom of the gallery frame.
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    Figure 3.22 : Thumbnail settings


    The Automatic Slideshow setting causes the images to scroll automatically without user interaction. You can stop the progress by placing the mouse on the image.


    3.3 Managing media files


    You can add video or sound files to any page.


    3.3.1 Adding Videos


    
      	Insert / Video


      	Select the type of video you want from the drop-down list at the top right of the Inspector. Choose from a YouTube video, a Vimeo video, a MP4 file stored on your computer's hard drive or from a network location.


      	Click on the Add button then specify either the URL for an online file or a file on disk.

    


    In the case of a YouTube or Vimeo video, after clicking the Add button, Sparkle displays a search box where you can type the first few letters of your video.


    Figure 3.23 shows the available settings.
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    Figure 3.23 : Inserting a video


    In the case of an MP4 file, there are several options available to set up the video. Figure 3.24 shows the settings.


    
      	Autoplay. The video starts automatically when the page is opened.


      	Loop. The video starts again at the end.


      	Mute. There is no sound.


      	Player Controls. The controls can be embedded in the video or located in the browser.


      	Custom Poster Image. It is an image that appears in the background of the video frame before it starts.


      	Embedding. This option enables you to embed the video with the desired effects. The Direct Embed option loads the video player directly onto the page. This feature may slow down the page loading slightly, but the playback will start faster. The Still + Embed option loads only the preview image initially then, on click, loads the video player. The page loads faster, but the player does not. The Still + Embed + lightbox option loads the preview image initially, but when clicked, the video is loaded into a lightbox. The video will always be seen in a larger size.
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    Figure 3.24 : Inserting a MP4 image file


    3.3.2 Adding a mp3 audio file


    It is the same principle as for the video.


    
      	Insert / Audio


      	Click on the Add button then choose the audio file.

    


    Figure 3.25 shows the settings of the audio file in the Inspector.
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    Figure 3.25 : The audio file settings


    Sparkle accepts only mp3 files because it is the only format that is reasonably compatible with all web browsers regardless of the platform. There is no automatic start.


    At the time of publishing, the mp3 file will be exported to the server with the other files of the website.


    
      	The Dark theme colors the background of the audio player in black.


      	The Custom theme enables you to apply another color for the volume slider.

    


    3.3.3 Inserting a Lottie animation


    A Lottie animation is an animation that is lighter than an animated GIF file, vector-based, faster and developed in the JSON format.


    These animations are accessible with Mac, Windows, IOS, Android and many others. The Lottie format tends to become a standard in the design industry.


    The dedicated Wiki page will give you more information. (https://fr.wikipedia.org/wiki/Lottie_(animation))


    Figure 3.26 shows the lottiefiles.com site.
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    Figure 3.26 : A site for Lottie animations


    Sparkle enables you to insert a Lottie animation into your project page with parameters to be set in the Inspector.


    Perform the following to insert a Lottie animation:


    
      	Insert / Lottie animation


      	Click on the Browse Animations button to display the website https://lottiefiles.com/recent that will enable you to select a royalty-free animation.
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    Figure 3.27 : Selecting a Lottie animation


    
      	Choose an animation then upload it to a folder on your computer.


      	Click on the Add button then specify the file you have chosen.


      	Preview your site to see your Lottie animation in action.

    


    3.4 Adding a Blog


    The Sparkle Pro version allows you to add a blog to your site.


    
      	Insert / Blog


      	Click on Add Blog Post
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    Figure 3.28 : Inserting a new blog


    Sparkle creates two new pages: a BLOG - Index page and a Blog Post page.


    A blog is a collection of posts whereby the more recent ones appear first, at the top of the stack.


    Figure 3.29 shows these two new pages.
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    Figure 3.29 : The two blog pages


    If you click on Add Blog Post again, a new predefined page will be created.


    3.5 Inserting a payment Button


    Several partner companies offer tools that can be integrated into websites to facilitate online payment via a payment button. Sparkle enables you to insert such a feature in the following way:


    
      	Insert / Payment


      	Click on the Placeholder list in the inspector.
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    Figure 3.30 : Online payment features


    
      	Select the partner then click on the Configure button.

    


    Figure 3.31 shows the general settings with the Payments tab
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    Figure 3.31 : The payments parameters


    
      	Click on the Get button.

    


    Sparkle will display the partner's site page that will prompt you for your account.


    This payment option is rather intended for developers because it requires the insertion of more complex programs called APIs (Application Program Interfaces) that are outside the scope of this book.


    For some of my books, customers can buy them directly from my site. A PayPal button displays the PayPal site immediately.


    Figure 3.32 shows the PayPal button for the book Bien débuter en programmation.
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    Figure 3.32 : A PayPal button is placed on the page


    When designing the page, the PayPal button comes from a HTML code provides by Paypal (figure 3.33).
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    Figure 3.33 : The PayPal button is created from HTML code.


    You can create as many buttons as you want from PayPal. Keep in mind that this button means a specified price and precise information.


    Figure 3.34 shows the PayPal site where this button has been created.
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    Figure 3.34 : Creating the button with PayPal


    In brief


    In this chapter you have studied how to insert text, images and media files. All the settings are available on the right panel. It is always possible to check the result by doing a preview before publishing.


    The Sparkle Pro version provides more powerful tools.


    Chapter 4 will deal with links between pages and special effects.

  


  
    Chapter 4

    Links and special effects


    This chapter deals with techniques of linking between pages, thanks to different elements placed on them. You will study menus and special effects that can enhance a presentation.


    4.1 Links between pages


    A Web site contains several pages that can interact with each other. A click on a link can trigger the appearance of a specific page and another link can take you back to the beginning of the site.


    The important point inside the site organization is to keep the same structure throughout the passage from one page to another. For instance, it is interesting to place a footer with your personal information on each page. Similarly, a visible logo will reassure your visitor.


    By organizing your site in a clear and well-defined way, you will create a security feeling, like in a store where you enjoy coming back to shop.


    First, create the pages that need to be linked, then insert links needed with the Inspector.


    4.1.1 Creating a link from a text


    To create a link from a text, perform the following steps:


    
      	Insert the text then select it.


      	Select the Style tab in the Inspector.


      	Click on the On Click drop-down list then choose

      Go to Page in This Website.
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    Figure 4.1 : Creating a link


    
      	Specify the name of the page using the drop-down list placed below.


      	Specify Top of Page to display the page from the top. The other setting New Scroll Position enables you to display a fairly large portion of a page. An anchor is created thereafter and will be used as a reference point.

    


    The list below details the link options (figure 4.1):


    
      	By default, the menu is set to Do nothing.


      	Go to Page in This Website. This option displays another page defined in the Inspector settings.


      	Go to External Link. This option enables you to declare a URL address.


      	Open Email. This feature starts your computer's default email application (Gmail, Outlook, Mail, etc.)


      	Call Phone Number. The number defined in the dedicated application is called.


      	Download File. This option enables you to download a file whose name is specified in the File name field.


      	Open Pop. This option enables you to open a configurable building block. You can use them as forms in order to create a user-friendly dialog box.


      	Close Popup. This option enables you to close the form previously opened.

    


    4.1.2 Starting an action from a button


    A button enables you to start an action defined in the Inspector, in the same way as for a text.


    To insert a button and assign an action to it, perform the following steps:


    
      	Insert / Button


      	Specify the actions to be performed in the Inspector.

    


    You can change the button position with its properties (figure 4.2).
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    Figure 4.2 : A button and its characteristics


    The right panel shows several groups of properties: Button, On Click, Mouse Hover, Font, Background, Mouse Hover for the color, Mouse Clicked and Scroll Effects


    The button label area enables you to change the caption of the button. An action can be triggered when clicking on the button. The action is specified in the drop-down list, as show figure 4.3.
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    Figure 4.3 : The button actions


    
      	By default, the menu is set to Do nothing.


      	Go to Page in This Website. This option displays another page defined in the inspector settings.


      	Go to External Link. This option enables you to declare a URL address.


      	Open Email. This feature starts your computer's default email application (Gmail, Outlook, Mail, etc.)


      	Call Phone Number. The number defined in the dedicated application is called.


      	Download File. This option enables you to download a file whose name is specified in the File name field.


      	Email Form via Server. This feature is more commonly used in forms where you describe input fields, checkboxes or radio buttons to select multiple choices. Information is requested such as a starting email address (which will only be visible to the recipient), a destination email address, a subject line and possibly a reply email address for the site visitor. It is also possible to define a thank-you page that will inform the user of the receipt of an email.
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    Figure 4.4 : Form parameters


    
      	Use Custom SMTP Server. Define here the port, the username and the password.
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    Figure 4.5 : SMTP parameters


    
      	Advanced Form Submission. This option enables you to specify a page that contains some PHP code on the server side of your Internet Service Provider. Define the URL where the code stands. Thereafter, the mail will be sent to this URL address.
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    Figure 4.6 : Advanced settings


    
      	Open Pop. This option enables you to open a configurable building block. You can use them as forms in order to create a user-friendly dialog box.


      	Close Popup. This option enables you to close the form previously opened.

    


    4.1.3 Rounding the button border


    Figure 4.7 shows two buttons. The corners have been rounded and the background color has been set to light blue. Each button calls a specific page.
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    Figure 4.7 : Rounded borders


    To round the border of a button, perform the following steps:


    
      	Insert / Button


      	Double-click on the button then type a text.


      	Change the background color by clicking on the Fill circle then select a new color.


      	Tick on the Border box and Rounding.


      	Tick on Same on all sides if you want the borders to be the same on each side.


      	Increase the size of the border by moving the slider slightly to the right.


      	Increase the size of the rounding by moving the slider slightly to the right.


      	Change the color of the rounding by clicking on the color circle.

    


    Figure 4.8 shows all these settings in the Inspector.
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    Figure 4.8 : The rounding parameters


    Figure 4.9 shows an example of a button where the rounding is not identical.
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    Figure 4.9 : Rounding is not identical.


    When the Same on all sides box is not checked, you can define four different types of rounding by manipulating the size, shape and color. This feature enables you to manage more customized shapes.


    4.2 Header and Footer


    A website always has several pages. You can define a header that will be repeated on all pages, for instance, a logo or business data.


    4.2.1 A header for all pages


    Here is the method that defines a header:


    
      	Place a text, picture or any object on the first page.


      	Select the object.


      	In the Inspector, click on the Arrange tab.


      	At the very bottom of the Inspector, tick on Show on All pages.

    


    The text or the different objects selected will be reproduced on all other pages. You will not be able to modify it because it is a read-only feature. Only the object inserted on the first page can be modified.


    Figure 4.10 shows an example of a logo and some texts that are repeated on all pages.


    The header can be useful for repeating a group of objects that you want to display on all pages. This group can be stored anywhere on the first page.
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    Figure 4.10 : Several objects are repeated on all pages.


    4.2.2 A header for a group of pages only


    To repeat an object on some pages only, you have to create a Section, i.e. a container of pages. Afterwards you can drag the pages into the section (either one by one or by selecting the pages). Then, you define an object to be repeated on the first page of this section.


    Here is the method:


    Step 1: Creating a section


    
      	Click on the sign + at the bottom of the left panel.


      	Choose Add a section
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    Figure 4.11 : Adding a section


    Step 2: Renaming the section


    Sparkle names the section Section1. Rename it to better understand the section content.


    
      	Click on the name of the section.


      	Rename the text that will correspond to the group of pages.

    


    Step 3: Moving existing pages into the section


    
      	Select the pages then drag them into the pink section area.


      	Click on the small white arrow to show the pages.

    


    Step 4: Inserting an object into the first page of the section


    
      	Insert a text or an image (or anything else) in the first page of the section.


      	Select the object.


      	Click on the Arrange in the Inspector.


      	Click on Show on all pages in this section.

    


    4.2.3 The footer


    The footer is usually a group of texts or other objects placed at the end of the page. If your site contains many pages, you can insert a footer by the following:


    
      	Insert the text or the image at the bottom of the first page.


      	Select the objects.


      	Click on the Arrange tab in the Inspector.


      	Choose Show on all pages.

    


    However, a problem may occur if your pages do not have the same length. Indeed, the footer will not be placed at the end of each page.


    To solve this problem, perform the following steps:


    
      	Select the footer for the first page.


      	Click on the Arrange tab.


      	Tick Follow Footer.


      	Tick Show on all pages

    


    You will notice that the text is now completely pasted into the footer, regardless of its length.


    4.2.4 Grouping elements


    Groups enable you to group elements on the page with parameters that affect the vertical scrolling (when there are several groups).


    To create a group of elements, carry out the following:


    
      	Select the elements.


      	Right-click


      	Select Group to group or Ungroup to ungroup.

    


    If you increase the horizontal or vertical size of the group, the size of the frames that contain the elements will also be increased.


    Figure 4.12 shows a group with several elements. Click on Layers in the left panel to see the name of each element of the group.
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    Figure 4.12 : Groups of elements


    To quickly insert a new element into a group, select an element then insert the new object.


    Groups have scrolling parameters (figure 4.13).
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    Figure 4.13 : The group properties


    
      	Normal scrolling. This option locks the group of elements at the top of the window instead of making it disappear with the scrolling.


      	Stack. The groups will be stacked and always visible.


      	Overlap. The groups will be able to overlap each other.


      	Last one pushes Previous. The last group makes the previous one disappear. Only one group is displayed at a time.


      	Fix to browser bottom. This option enables the group not to scroll with the page but rather to be stuck to the bottom of the browser window by its lower edge.

    


    4.2.5 Parallax effects and templates


    The ability to scroll groups of elements gives the impression that the objects move relative to each other with very nice 3D effects and illusions. This effect is called parallax effects.


    The parallax effect is an observation change of many objects. When you scroll down the elements of a page, you can have the feeling that some pictures or texts are placed on top of others.


    These layers of objects that move in the vertical plan and the mouse interaction create a speed/perspective effect.


    With Sparkle, parallax effects are offered in templates that you can discover when creating a new project.


    To create a new template, perform the following steps:


    
      	File / New


      	Click on a template. For instance, choose the Seasons template.

    


    Figure 4.14 shows the single page of this site with several text boxes and groups of objects. In order for the parallax effect to take place when scrolling, the text box named Box1 is stretched and fixed in the window.


    It is the background that is fixed and the other objects revolve around it.


    You can use the parallax effect to develop very beautiful presentations.
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    Figure 4.14 : The Seasons template


    4.3 Creating a customized menu


    A menu is a feature that displays the name of items on your site. For instance, if your project is to develop a site about recipes, you can create three pages: Starters, Dishes and Desserts and a home page which will contain an object menu.


    When the user clicks on one of the menu items, the selected page will be displayed immediately, with the possibility of returning to the menu, thanks to a button.


    4.3.1 The pages of the site


    The following list details the four pages of the project:


    
      	The first page is the Home page. Its name is Menu but the html name is Index.html.


      	The second page is a regular page. Its name is Starters and the HTML name is Starters.html.


      	The third page is a regular page. Its name is Dishes and the HTML name is Dishes.html.


      	The fourth page is a regular page. Its name is Desserts and the HTML name is Desserts.html.

    


    The next three figures show the site pages.
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    Figure 4.15 : The Starter page
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    Figure 4.16 : The Dishers page


    [image: ]


    Figure 4.17 : The Desserts


    The first page will contain the menu object.


    Step 1: Inserting a menu object


    
      	Select the first page.


      	Insert / Menu

    


    Figure 4.18 shows the menu object in the first page.
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    Figure 4.18 : The menu object


    To organize a menu with elements that can have actions, you must change the properties. Figure 4.19 shows them in the right panel.
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    Figure 4.19 : The menu properties


    Follow the next step to create a submenu with the pages on which you will be able to declare actions:


    
      	Select the Home element in the properties.


      	Click on the Folder icon at the right of the sign -.Sparkle will create an item element, as shown in figure 4.20.
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    Figure 4.20 : Creating an item element


    
      	Drag the three pages under the item element (figure 4.21).
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    Figure 4.21 : Dragging the pages


    
      	Place the pointer on the item element above the STARTER page, then click on the sign - to remove it (figure 4.22).
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    Figure 4.22 : The item submenu


    The next step is to rename the item element.


    
      	Place the pointer on the item element.


      	Rename the name in the ITEM LABEL area (figure 4.23).
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    Figure 4.23 : Renaming the item element


    
      	Place the pointer to the STARTER element. You will see that it is linked to the STARTER page automatically (figure 4.24).
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    Figure 4.24 : The element is linked to a page


    
      	Preview the web site then test the submenu.

    


    4.3.2 The submenu layouts


    A submenu can be displayed in several ways, horizontally or vertically with different possibilities.


    Figure 4.25 shows the submenu properties.
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    Figure 4.25 : Submenu possibilities


    The Width enables you to enlarge the menu using the Height properties.


    Figure 4.26 shows all the possibilities with the Custom Style.


    You can change the background color of the submenu, round the corners, define a shadow effect, space the elements, specify the color for the mouse hover, etc.


    [image: ]


    Figure 4.26 : The custom style


    4.4 A site with a single page and anchors


    Numerous sites propose a single page containing all the topics and elements. Each topic is separated from the others by a named anchor. It is a visual cue that will be used to place the topic at the top of the page. The templates provided by Sparkle use this feature.


    The list below details the interest of anchors:


    
      	The site is contained in a single page.


      	The elements are one below the other.


      	The anchors correspond to the new scroll positions.


      	A button does not call up a page, but shift the display to a previously defined Scroll Position.

    


    Figure 4.27 shows this technique used in the Balloon Travel template.
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    Figure 4.27 : The anchors in a single page


    Figure 4.28 shows the prior example with the 3 pages copied into a single page.
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    Figure 4.28 : The information is stored in a single page


    Perform the following steps to create an anchor on the page.


    
      	Click on the Style tab in the Inspector.


      	Select a button or a text to create a link.


      	On click: Go to Page in this Website


      	Click on Page Top then select New Scroll Location.


      	Move the anchor to the desired position on the page.


      	Select the anchor and rename it (if needed) in the Name field.

    


    You can create as many new scroll positions as you need.


    Figure 4.29 shows the anchor properties.
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    Figure 4.29 : The anchor


    In brief


    A site can be built with several pages in which links enable you to move from one page to another. If the site is organized with only one page, the anchor feature is used to go directly to a part of the page.


    Chapter 5 will show you how to use styles that make it easier to format paragraph headings. You will also discover how to set up an interactive form with the user.

  


  
    Chapter 5

    The styles and the form


    This chapter shows you how to use styles that will help you to structure paragraph headings better. This feature enables you to define HTML tags that participate widely in referencing. You will also learn how to create an interactive form with the Internet user.


    5.1 Saving time with styles


    A style is a set of characteristics such as the size, color or position that applies to paragraphs. Most of the time, you will use styles to mark headings in order to facilitate their formatting and especially their possible modification.


    Imagine a site with 30 pages with offset headings. If you want to change the offset for these pages, you only have to change the style settings once.


    The other advantage is that styles participate in the referencing by the search engines that will recover the HTML tags.


    5.1.1 An example of style in a page


    Figure 5.1 shows the content of the Getting Started with OpenOffice CALC book description. The heading has a well defined style and a H1 HTML tag.
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    Figure 5.1 : The styles structure the paragraphs.


    On a page you can divide the text by paragraphs. The chapter name is always the level 1, with a H1 tag. The first heading can be defined with a level 2, with a H2 tag. The text can be specified with a body style using a P tag, etc.


    When using styles, several of them have a default name that you can rename, in necessary.


    5.1.2 Modifying an existing style


    When creating a new project, new default styles are available, as shown in figure 5.2, where a text has been inserted. Always keep in mind that styles are helpful for heading organization.
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    Figure 5.2 : The default styles


    The following shows an example of modifying a style:


    
      	Select the first text.


      	Click on the Body style.


      	Change the police to Lato with a size of 26 and Bold.


      	Click on Apply changes to update the style characteristics.

    


    Figure 5.3 shows the Body style.
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    Figure 5.3 : Updating a style


    
      	Insert two new texts.


      	Click on the body style to apply the new format.
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    Figure 5.4 : Applying a style


    5.1.3 Creating a new style


    It is an always good idea to create a style based on an existing text with a particular format.


    
      	Insert your text.


      	Format the text with the Inspector.


      	Click on the black down arrow beside the style.


      	Click on the + sign


      	Define a name for the new style in the area at the end of the styles.


      	Enter to finish.

    


    5.1.4 Removing a style


    Figure 5.5 shows where you can remove any style.
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    Figure 5.5 : Removing a style


    Styles can be used in both long text and dialog boxes called form.


    5.2 The form


    You will use this feature when you need information to be interactive with the user. For instance, it can be a text entry, a checkbox, option buttons, a validation button, etc. The data is inserted in a pop-up or on a site page. A validation button will send the entered information to a server and a PHP program will process it. These parameters are defined in the Inspector.


    5.2.1 The popup


    It is the window in which you place form elements. Its purpose is to enable a dialogue with the visitor. You can create as many forms as you like. The Layers panel can help you view the content of the popup.


    Warning: The pop-up window must be stored in the page that contains the calling button.


    To create a pop-up window, perform the following steps:


    
      	Select the page that will call the pop-up.


      	Insert / Pop-up.


      	Click on the Arrange tab. The window is called Popup 1. You can rename it.
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    Figure 5.6 : The pop-up


    The next step is to insert the form elements into the pop-up object.


    5.2.2 Inserting form elements


    Sparkle provides several elements that can interact with the web user: a text input, a checkbox, an option button, a button, a drop-down selection, and a file-attachment object.


    When using these elements, you have to rename them in order to manipulate them more easily thereafter. Indeed, these words are used when the form is validated and the data is sent to the server.
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    Figure 5.7 : The interactive objects


    To insert a text input placeholder, perform the following steps:


    
      	Select the pop-up.


      	Insert / Text Input

    


    This text input area can be moved like any other object and all its properties are available in the Style tab.


    To place a caption in front of a text input, use the Text Box object.


    Figure 5.8 shows four Text Input boxes in the pop-up with a button to send the data to the sever.


    All the inputbox are named.
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    Figure 5.8 : Four text entry boxes with captions


    For the first name, the input field name is txt_firstname.


    For the surname, the input field name is txt_surname.


    For the zip code, the input field name is txt_zip.


    For the city, the input field name is txt_city.


    If you click on another site page, you will see that the pop-up will disappear. To modify the pop-up again, use the Layers features, then click on the pop-name which will appear.


    The name of the pop-up can be renamed. Double-click on the name then rename it.


    Figure 5.9 shows the Layers.
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    Figure 5.9 : The Layers is used to show the pop-up objects


    5.2.3 Calling a pop-up from a button


    From any page, a pop-up can be called thanks to a button or any link whose On Click property is Open popup specifying the name of the pop-up.
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    Figure 5.10 : Calling the MYFORM popup


    When the page is previewed, click on the button to make the pop-up appear.


    The pop-up properties have two features: Modal/LightBox or Fixed In Window.
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    Figure 5.11 : Modal or fixed feature


    
      	Modal/LightBox. You cannot access the site page.


      	Fixed In Window. The pop-up position is fixed with parameters.

    


    5.2.4 Sending information to the server


    Sparkle provides the classical communication protocols for sending information from the form elements to a server.


    The settings can be defined from a button or a link.


    Two main series of parameters are available:


    
      	Email Form via Server


      	Advanced Form Submission

    


    Figure 5.12 shows the Email Form via Server property defined for a button.
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    Figure 5.12 : Sending data with the Email protocol


    When the form is submitted by the client, the form information will be sent to you, the recipient.


    You can also use the other protocol: Use custom SMTP server. Figure 5.13 shows the settings to implement.
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    Figure 5.13 : Sending data with the SMTP protocol


    You can send data with an Advanced Form Submission. It enables you to define a POST or GET communication protocol.


    Figure 5.14 shows the properties of this feature.


    [image: ]


    Figure 5.14 : Using a Post protocol


    The GET/POST protocol requires a server-side PHP script to take over.


    5.3 Enhanced page controls


    Other controls can be inserted in a page. For instance a Checkbox, some Radio Buttons, a Drop-down Selection or a Smart Field.


    5.3.1 Inserting a checkbox


    Follow the next step to insert a Checkbox object then modify the properties:


    
      	Insert / Checkbox


      	Modify the label and the layout as shown in figure 5.15.
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    Figure 5.15 : The checkbox attributes


    5.3.2 Inserting a radio button


    Follow the next step to insert a Radio button object then modify the properties:


    
      	Insert / Radio Button


      	Modify the labels and the layout as shown in figure 5.16.
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    Figure 5.16 : The radio button attributes


    5.3.3 Inserting a Drop-down Selection


    Follow the next step to insert a Drop-down Selection then modify the properties:


    
      	Insert / Drop-Down Selection


      	Change the text of the placeholder.


      	Click on the Add button to add an element then repeat for more elements in the Drop-down Selection.

    


    Figure 5.17 shows the result with the attributes.
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    Figure 5.17 : The Drop-down Selection


    5.3.4 Inserting a Smart Field


    Smart Fields are compelling tools that can help you display dynamic text, date/time, photo information, math formulas and so on.


    Smart Fields have a bubble-like appearance when inserting them. Click on one to see the settings.


    
      	Insert


      	Smart Field

    


    Figure 5.18 shows the different objects like Page Title, Date/Time, Countdown, Counter, Typewriter, Math Formula, Code Snippet, etc.
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    Figure 5.18 : The smart fields


    In brief


    Styles allow you to set up paragraph headings saving you time. Thanks to a form, your visitors can interact with your site. If needed, several communications are available to use with a form.

  


  
    I hope this book has improved your knowledge about SPARKLE and will help you in your work.


    Do not hesitate to contact me at REMYLENT@GMAIL.COM if you have any comments or questions.
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